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Statements
CONDITIONS ON WHICH THIS MANUAL AND ANY RELATED SOFTWARE
AND SERVICES ARE PROVIDED TO RECIPIENT
By accepting or using this manual and any related software (Software) and services (Services)
provided by First American Registry, Inc., the recipient agrees to the following terms and
conditions:
PROPRIETARY INFORMATION
This manual and any Software contain confidential information constituting trade secrets of
First American Registry, Inc. This manual and any Software are furnished to recipient solely to
enable recipient to utilize The Credit Connection for the purposes permitted under recipient’s
agreement with First American Registry, Inc. (Subscriber Agreement), and recipient shall not
use this manual or any Software for any other purpose. Recipient shall make this manual and
any Software available only to its employees who have an actual need to access them in order to
enable recipient to obtain The Credit Connection resident screening reports from First American
Registry, Inc. Recipient shall not provide this manual or any Software (or any part thereof) to
any third party. Recipient shall not reproduce any Software (except for backup purposes), and
shall not reproduce this manual (or any part thereof) without First American Registry, Inc.’s
prior written consent. At the termination of the Subscriber Agreement, or earlier at the request
of First American Registry, Inc., recipient shall promptly return this manual and any Software
(and any copies made by recipient) to First American Registry, Inc. Recipient shall take
reasonable steps to ensure that its employees comply with the foregoing restrictions.
RELEASE AND LIMITATION OF LIABILITY
RECIPIENT RELEASES FIRST AMERICAN REGISTRY, INC. FROM ANY AND ALL
DEMANDS, ACTIONS, LOSSES, COSTS, EXPENSES, DAMAGES, LIABILITIES, PENALTIES,
AND OTHER CLAIMS IN CONNECTION WITH THIS MANAUAL OR ANY SOFTWARE,
THE CREDIT CONNECTION RESIDENT SCREENING REPORTS, OR OTHER PRODUCTS
OR SERVICES PROVIDED BY FIRST AMERICAN REGISTRY, INC. IN NO EVENT WILL
FIRST AMERICAN REGISTRY, INC. HAVE ANY LIABILITY TO RECIPIENT OR ANY
THIRD PARTY FOR INCIDENTAL, SPECIAL, CONSEQUENTIAL, OR ANY OTHER
DAMAGES IN CONNECTION WITH THIS MANUAL OR ANY SOFTWARE, THE CREDIT
CONNECTION RESIDENT SCREENING REPORTS, OR OTHER PRODUCTS OR SERVICES
PROVIDED BY FIRST AMERICAN REGISTRY, INC.
DISCLAIMER OF WARRANTIES
FIRST AMERICAN REGISTRY, INC. DOES NOT MAKE ANY REPRESENTATION OR
WARRANTY, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED
WARRANTIES OR MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR
AS TO NONINFRINGEMENT, WITH RESPECT TO THIS MANUAL OR ANY SOFTWARE,
THE CREDIT CONNECTION RESIDENT SCREENING REPORTS, OR OTHER PRODUCTS
OR SERVICES PROVIDED BY FIRST AMERICAN REGISTRY, INC., NOR ARE THERE ANY
WARRANTIES CREATED BY COURSE OF DEALING, COURSE OF PERFORMANCE, OR
TRADE USAGE, AND FIRST AMERICAN REGISTRY, INC. EXPRESSLY DISCLAIMS ALL
SUCH REPRESENTATIONS OR WARRANTIES. IN ADDITION, FIRST AMERICAN
REGISTRY, INC. DOES NOT WARRANT THAT THIS MANUAL OR ANY SOFTWARE, THE
CREDIT CONNECTION RESIDENT SCREENING REPORTS, OR OTHER PRODUCTS OR
SERVICES PROVIDED BY FIRST AMERICAN REGISTRY, INC. WILL BE FREE FROM
ERRORS, WILL MEET RECIPIENT’S NEEDS, OR WILL BE PROVIDED ON AN
UNINTERRUPTED BASIS.
RIGHT TO RETURN
Recipient may indicate that it will not be bound by the foregoing terms by returning this
manual and all Software to First American Registry, Inc. within five days after receipt.
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Registered Marks
First American and the eagle logo are registered service marks of The First American Financial
Corporation.
The Credit Connection is a registered trademark of First American Registry, Inc.
Microsoft and Windows 95/98 are registered trademarks and Windows is a trademark of
Microsoft Corporation.

All registered trademarks, trademarks, and service marks are the property of their respective
owner.
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Ordering Publications

Copies of this publication or copies of any other First American
Registry, Inc. publication can be obtained by contacting your First
American Registry, Inc. representative or by writing to:

First American Registry, Inc.
Attn: Publications Dept.
12395 First American Way
Poway, CA 92064

When ordering publications, include the document title, the
document number, and the edition date.
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1 Introduction
Welcome to The Credit Connection (TCC) for Windows,
the newest resident screening report ordering and
processing product from First American Registry, Inc. TCC
for Windows is a system of hardware and software used to
produce fast, accurate reports. Using the TCC for Windows
software and your computer, applicant data is sent to First
American Registry, Inc.’s host computers, repository data is
obtained and processed, and the final merged report arrives
back at your PC.
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1.1 Features

TCC for Windows application includes the following
features:

♦  Easy to use interface
♦  Native Windows application
♦  Easily filled-in window for applicant data

collection
♦  Easy setup and use of multiple report types for

convenient report selection
♦  Rapid report generation and delivery
♦  One, two, or three credit repository requests are

merged into a single report
♦  Management reports
♦  Built-in modem database (select from hundreds of

common modems)
♦  Communicates via the public telephone system
♦  Provides its own telecommunications software

(no other communications software is required)
♦  Allows a variety of transmission options

! Single resident screening report application
! Multiple resident screening report

applications
! Batch transmission of any subset of the

applications, or all of the applications
♦  Provides for a variety of configuration options
♦  Printer and communication port selection
♦  File and program access security
♦  Transaction logging
♦  Communication Error Logging
♦  Easy to understand error messages.
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1.2 Hardware Requirements

The following list defines the TCC for Windows hardware
requirements:

♦  486 DX-66  (or higher) IBM Compatible PC
♦  VGA (or higher) Video Adapter
♦  16 Megabytes Available Hard Drive Space (20

Megabytes recommended)
♦  8 Megabytes RAM - Windows 3.1 and Windows

for Workgroups
16 Megabytes RAM - Windows 95/98

♦  Hayes Compatible Data-Fax Modem - 14.4 BPS
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1.3 Software Requirements

The TCC for Windows software requires the use of one of the
following operating systems:

♦  Microsoft  Windows 3.1
♦  Microsoft Windows for Workgroups
♦  Microsoft Windows 95/98
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1.4 Technical Support

Technical support is available through the First American
Registry, Inc. Help Desk. For assistance, call:

(800) 369-9174
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2 Installing the Software
TCC for Windows software is installed on the PC using a
floppy disk drive and a hard disk drive. Each drive has a
letter designator that the operating system recognizes as
belonging to that drive.

A typical computer configuration offers a 3.5” floppy
diskette as “Drive A:” or “Drive B:” , a hard disk as “Drive
C:”, and a CD-ROM drive as “Drive D”. Therefore, the
installation in this configuration would be from floppy
drive “A:” or “B:” to hard drive “C:”, or from CD-ROM drive
“D” to hard drive “C”.

To determine the correct letter designator for each drive,
refer to your computer’s documentation or check with your
System Administrator.

NOTE: Installation of TCC for Windows
software requires 16 Megabytes of disk space.
However, it is recommended that you have
20 Megabytes of disk space available for
running TCC, since each report generated
requires storage space.

The following sections detail the steps required to install
the software. If you are using Windows 3.1 or Windows for
Workgroups, perform the installation instructions detailed
in Windows 3.1 Installation. If you are using Windows 95/98,
perform the installation instructions detailed in Windows
95/98 Installation.
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2.1 Windows 3.1 Installation

1. Place Disk 1 of TCC for Windows installation
diskettes in the floppy disk drive.

2. From the Program Manager, select the File menu
and click on Run.

3. In the Run dialog box, enter:
 A:\INSTALL

4. Click on OK to launch the installation program.

5. Enter the requested information for each
installation window displayed and click the Next
button.

6. When prompted by the installation program,
remove and insert the remaining installation
diskettes.

7. Click on the Finish button, when the Installation
Completed window is displayed.
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After TCC for Windows is installed, configuration for
modem and printer settings, communication ports,
telephone numbers, account information, and report types
is required. The required configuration windows are
displayed when TCC for Windows is initially started. Refer
to Chapter 3, Configuring the Software for details on using the
configuration windows.
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2.2 Windows 95/98 Installation

If you are using Windows 95 or 98, you can install the
software using either of the two following methods:

2.2.1 Automatic Installation Using A CD-ROM

Most Windows 95/98 PC’s ship with a CD-ROM drive that
features an “auto-play” option. If this option has been
enabled, software installation, and music CD’s, inserted
into the drive will automatically start whenever the drive
door is closed. Most software installation CD’s now provide
an “auto-start” capability to take advantage of this unique
feature.

The installation CD will automatically load the software
installation program for you if your CD’s “auto-play”
option has been enabled.

2.2.2 Manual Installation

1. Place the Installation CD in the CD-ROM drive or
Disk 1 of TCC for Windows installation diskettes in
the floppy disk drive.

2. From the Start menu, select Run.

3. In the Run dialog box, enter:
 A:\INSTALL or D:\INSTALL

4. Click on OK to launch the installation program.

5. Enter the requested information for each window
displayed and click the Next button.

6. When prompted by the installation program,
remove and insert the remaining installation
diskettes.

7. When the Installation Complete window is
displayed, click on the Finish button.
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After TCC for Windows is installed, configuration for
modem and printer settings, communication ports,
telephone numbers, account information, and report types
is required. The required Configuration windows are
displayed when TCC for Windows is initially started. Refer
to Chapter 3, Configuring the Software for details on using the
Configuration windows.
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2.3 Starting the Software

The following sections detail the steps to start TCC for
Windows software. If you are using Windows 3.1 or
Windows for Workgroups, perform the instructions
detailed in Starting TCC Using Windows 3.1. If you are using
Windows 95/98, perform the installation instructions
detailed in Starting TCC Using Windows 95/98.

2.3.1 Starting TCC Using Windows 3.1

1. From the Program Manager, open the Group
entitled TCC for Windows.

2. Double-click the The Credit Connection 2.0 icon
to start the program.
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2.3.2 Starting TCC Using Windows 95/98

1. Click on the Start menu button.

2. Select Programs → TCC for Windows → The Credit
Connection.
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2.4 Exiting the Software

To exit TCC for Windows, click on the Exit button located
in the lower right-hand portion of the main window.
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3 Configuring the Software

All of the configuration
windows can be accessed
from the Setup menu
within TCC for Windows.
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3.1 Customer Profiles Window

The Customer Profiles window is used to enter your First
American Registry, Inc. account information and select the
order in which the credit repositories are accessed.

Red text box titles indicate that an entry in
the associated text box is mandatory.
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3.1.1 Completing a profile

Use the following information to complete a customer
profile:

1. Enter your account number in the Account Num
text box. This number is supplied by First
American Registry, Inc..

2. Enter your customer password in the Password
text box. This password must be on file at First
American Registry, Inc..

3. When the Apt.
Association check
box is selected
with a ". Enter
your member name in the Member Name text box.
(This text box is not available for input when the Apt.
Association check box is deselected.)

4. When the Apt.
Association check
box is selected
with a ", enter
your member number in the Member Number text
box.
When the Apt. Association check box is deselected,
enter the management company or owner name
in the Mgmt Co/Owner Name text box.

5. Enter the caller name in the Caller Name text box.

6. Enter the caller’s phone number in the Caller Phone
text box.
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7. If you use an internal identification code that
identifies a specific building, enter the code in the
Bldg Code text box. This text box is optional.

8. In the Bureau Preferences section, select the order
that you want the repositories accessed. Enter 1,
2, or 3 in the text box associated with a specific
repository. The repository marked with 1 is the
first repository accessed by the program. If it is
unavailable, the repository marked with 2 is
accessed. The repository marked 3 is accessed if 2
is also unavailable.  If you do not want reports
from a specific repository, set that repository’s
number to 0. Any repository with a priority
number of 0 will automatically be skipped.

NOTE: To reset the repository order, set the
text boxes back to zero and restructure the
numbering sequence.

10. Click on Done to save the information entered
and exit the window.
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3.2 Phone Numbers Window

The Phone Numbers window is used to select a primary and
an alternate telephone number to connect your computer
to the First American Registry, Inc. facility.

There are three telephone number types:

♦  Local – Used when only the 7-digit number is
dialed.

♦  Long Distance – Used when both the area code
and the number 1 must be dialed before the 7-digit
number.

♦  10-Digit Dialing – Used when only the area code
and the 7-digit number are required. These
numbers are used when the Telephone Company
has ‘split’ an area code into two or more area codes
but retains local calling charges for the new area
code.
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1. Enter the primary telephone number in the
Primary text box. The full 10-digit phone number
must be entered. This number is the first number
dialed. An entry in this text box is mandatory.

2. Select the telephone number type by clicking on
Local, Long Distance, or 10-Digit Dialing so that a #
appears in the button.

3. Enter the secondary telephone number in the
Secondary text box. The full 10-digit phone
number must be entered. This number will be
dialed if the primary number is unavailable.

4. Select the telephone number type by clicking on
Local, Long Distance, or 10-Digit Dialing so that a #
appears in the button.

5. Enter a dial prefix in the Dial Prefix text box if
required at your location. If a pause is required
between any digits, enter one or more commas.
Dial prefixes are required by some telephone
systems to obtain an outside line. This field can
also be used to turn off the Call Waiting feature.
Contact your System Manager, or local Telephone
Company, for special codes used in your area.

6. Click on Done to save the information entered
and exit the window.
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3.3 Report Types Window

TCC has a very sophisticated report package available to
help you with your client needs. Because each user has
unique requirements, TCC now lets you quickly customize
unique report packages – each one specially tailored to meet
one of your current business needs.

TCC reports are delivered to your computer after
processing is completed. You can view, print, and delete the
reports at any time after receiving the completed report.

3.3.1 Report Types

The Report Types window is
used to define report type
profiles. Using this window,
report types can be created,
changed, or deleted.

The Report Types window is a TCC form. Refer to Chapter
10, Working with Forms for information on working with
columns and rows.
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Report types must be defined before you can request
information on a client. You will be prompted to set up
your custom reports as soon as the system is installed.

Report types are defined by assigning a package name and
selecting the report options you wish to be included in that
package. The total number of custom reports you define,
and the contents of each of these reports, is under your
total control. To make your experience with TCC more
pleasant and productive, please use package names that
describe as clearly as possible the reporting function of each
report package.
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3.3.2 Setting Up New Reports

To define a new report type:

Enter the package name in the
Package Name column.
Remember to use package names
that describe as clearly as possible
the reporting function of each
report package

 

 
 (NOTE: There is a 30-
character limit on
report names.)

The first column to the right of
the Package Name column is the
Settings column.

Click the Settings button if you
want to change (override) the
Bureau Preferences you chose
when you setup your Customer
Profile account.

To modify your
preferences, simply click
on the " in box to
uncheck Use Customer
Profile Preferences.
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When this box is empty,
you will be able to enter a
number in the appropriate
Bureau field(s). The
numbers indicate which
Bureau is your first choice
for information, second, etc.

To complete the rest of the report, select the options
you want to include in this report by clicking on the
check box so that a " appears in the box. (Use the
scroll bar at the bottom of the screen to access
additional options not displayed.)

 

A " in the box in the Joint column
indicates that this report includes a
co-applicant.

The next column, Number of
Bureaus, allows you to choose how
many Bureaus will provide your
information. Simply click in the
field to display the , which
activates the drop-down menu.
Choosing “DOUBLE” means that
this report will pull information
from the 1st two Bureaus.

 

 

 Note: Your selection here indicates the total
number of bureaus you desire to provide
information. The order in which they are polled
is initially established when you setup your
Customer Profile account. This order is overridden
by your selection (if any) in the Settings column
described earlier.

Placing a " in this box will add
TeleCheck to the list of reports included
in your custom report package.
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If you would like this client to be
evaluated against bureau risk criteria
place a " in the Risk Factor column box.

To run a quick fraud check on this
individual, place a " in the Fraud Check
box.

 
 

 
 

To run a quick social security number
check on this individual, place a " in the
Social Search box.

To obtain a more detailed report of
credit activity on this individual, place a
" in the Creditor Detail box.

 
 

 
 

To obtain information on this individual
previous residences, place a " in the
Tenancy box.

To determine if this individual has ever
been evicted, place an " in the Unlawful
Detainers box.

 
 

 

 
 

To obtain a recommendation on whether
or not this individual should be accepted
or rejected, based on your previously
identified criteria, place an " in the
Decision Maker box.

To run a quick check on this individual
through the Department of Motor
Vehicles/Motor Vehicle Department, place
an " in the DMV/MVR box.
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To determine if this individual has a
criminal record in Southern California,
place an " in the So. Cal Criminal box to
check local law enforcement agencies. Note:
You may choose only one of the three criminal
checks.

To run a criminal record check on this
individual covering standard FBI, etc. law
enforcement records place an " in the
Standard Criminal box. Note: You may choose
only one of the three criminal checks.

 

 
 

 

 

To run a criminal record check on this
individual covering local state law
enforcement agencies records place an " in
the State Criminal box. Note: You may choose
only one of the three criminal checks.

To run a complete verification check on
this individual’s listed residences place
an " in the Residential Verification box.

 

To run a complete verification check on
this individual’s listed employment
place an " in the Employment Verification
box.

Click on Done to save the information
entered and exit the window.
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3.3.3 Setting a Default Report Type

The default report type can be selected from the report
types defined on the Report Types window. To select a new
default report type:

1. Click on the
package name of
the desired report
type. A button
appears at the
right.

[There is a 30-character limit on report names.]

2. Click on the button. A confirmation message
window asks if you want to set the selected report
as the default.

3. Click on the OK button to select the new default.

After you have selected and
verified the default report, that
package name and its
associated options are displayed
at the top of the report types
list. The new default package
name is now displayed in red.
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3.4 Port Setup

The information entered in
the Port Setup window
controls the communication
settings that establish a
communications path
between your computer and
the First American Registry,
Inc.  computers.

Use the following steps to define the communication
settings:

1. Ensure that the setting for Com Port matches the
setting appropriate for your modem.

2. Enable hardware flow control for baud rates of
9600 or above. Click on the Hardware (RTS/CTS)
check box, so that an " appears in the box.

3. Click on OK to save the communications settings.
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The remainder of the
options within the
dialog box should not
be modified unless
directed by Help Desk
personnel.

NOTE: If your modem is able to dial, but
stops transmitting or cuts off before receiving
any data, click on the Set DTR line high check
box, so that a " appears in the box.
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3.5 Modem Setup

The information entered in the Modem Setup window
configures the software with the correct initialization
string for the selected modem make and model.

NOTE: When selecting the modem make and
model, if your modem is not listed, select
Hayes in the Make section. In the Model
section, select the Compatible model closest to
your modem.

1. Select the modem make (manufacturer or brand-
name) from the Make section of the dialog box.

2. Select the specific model from the Model section of
the dialog box.

3. Enter the communication port that corresponds to
your modem’s setup in the Comm Port text box.

4. Click on OK to save the modem settings.
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3.5.1 Modem Utilities

The Modem Setup window includes a utilities feature that
allows you to add or delete modems, change the modem
settings, or pack the database. To display the Utilities menu,
click on the word Utilities at the top of the window.

NOTE: Only technicians experienced in
modem communications should add, delete,
or make changes to a modem’s setup. Refer to
your modem manual for the proper settings
for your particular modem make and model.
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♦  Edit Settings – When Edit
Settings is selected, the
Modem Strings window
for the currently selected
modem is displayed.
Changes can be made to
the settings used with that specific modem make
and model.

♦  Add Modem– When Add Modem is selected, the
Modem Strings window is displayed. A new
modem can be added by entering the required
information in the window text boxes.

♦  Delete Modem – When Delete Modem is selected,
the currently selected modem is deleted.

♦  Pack Database –When Pack Database is selected,
the database is compacted. This means that a copy
of the database is made and rearranged to
minimize disk usage and increase operation speed.
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3.6 Reconnect Modem

Because TCC for Windows allows
you to use your modem with
other applications, you will need
to “reconnect your modem”
before you attempt to generate
report requests or retrieve results.
To do this, simply “click” on this
menu option.
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4 Using TCC for Windows
The following sections detail information on using TCC for
Windows software.

If you are using Windows 3.1 or Windows for Workgroups,
perform the instructions detailed in Starting TCC Using
Windows 3.1.

If you are using Windows 95/98, perform the installation
instructions detailed in Starting TCC Using Windows 95/98.

Once you have gotten TCC for Windows started, it operates
basically the same way under either operating system.
Therefore, the remainder of these instructions and helpful
hints will be pooled together.  For simplicity, most of the
screen pictures and descriptions have been completed using
the Windows 95 or Windows 98 operating systems.
Windows 3.1 users should be aware that their screen might
look slightly different — even though the basic
functionality remains the same.
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4.1 Starting TCC Using Windows 3.1

1. From the Program Manager, open the Group
entitled TCC for Windows.

2. Double-click the The Credit Connection 2.0 icon
to start the program.
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4.1.1 Enter User Initials  and Password

TCC for Windows provides a security function that protects
access to the program. If the security feature is setup and
activated, TCC for Windows displays the Security window
each time the software is started.

To access TCC for Windows:

1. Enter your user identification (initials) and
password.

2. Click on the Done button.

For more information on setting up, or changing, the security
function, please refer to Chapter 5, Security and User Administration.
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4.2 Starting TCC Using Windows 95/98

1. Click on the Start menu button.

2. Select Programs → TCC for Windows → The Credit
Connection.
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4.2.1 Enter User Initials and Password

TCC for Windows provides a security function that protects
access to the program. If the security feature is setup and
activated, TCC for Windows displays the Security window
each time the software is started.

To access TCC for Windows:

1. Enter your user identification (initials) and
password.

2. Click on the Done button.

For more information on setting up, or changing, the security
function, please refer to Chapter 5, Security and User Administration.
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4.3 Menu Bar

The menu bar provides drop down menus to access file
functions, configuration setup windows, security functions,
and online Help.

4.3.1 File Menu

The File menu allows you
to choose from multiple
databases, send requests,
cancel a process, print
reports, view reports, start
the batch process, auto
print, select a printer, access
the management report
function, view the Error
Log, view the Transaction
Log, clear the Transaction
Log, clear the Error Log, and
exit the software.
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4.3.2 Setup Menu

The Setup menu allows
you to access
configuration windows
used to select
configuration options for
communication port
setup, modem setup,
customer preferences,
phone numbers, and
report types.

For more information on the Setup menu, refer to Chapter 3,
Configuring the Software.

4.3.3 Options Menu

The Options menu provides two options to help you
customize TCC to your needs.

The first is a simple “toggle” to identify if you belong to an
apartment association.

If you place a ! by the
Apartment Assoc. menu
item you will be
presented a slightly
different set of fields in
the Customer Profile setup window and also in the Request
Information window.
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The second menu item offers three Sort Profiles for your
client records. They may be sorted By Account Number, By
Account Name, or By Member Number.

4.3.4 Security Menu

The Security menu provides
access to the Security
window. This window
allows you secure access to
the system by assigning
user identifications and passwords for a system manager,
administrator, and multiple users.

For more information the Setup menu, refer to Chapter 5,
Security and User Administration.
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4.3.5 Help Menu

The Help menu provides access to online Help, Technical
Support Information, and information about TCC
software.
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4.4 Button Bar

The button bar, located below the menu bar, contains
buttons that provide access to the Send, Batch, Cancel,
Report, and Print, functions.

 

♦  Send - Sends the current resident screening report
request(s).

♦  Batch - Batch process all marked resident
screening report requests.

♦  Cancel - Cancel the action currently in process.
♦  Reports – Open a reports list for the current client

showing all reports available to view or print.
♦  Printer Icon - Auto Print feature. Automatically

prints reports as they are received. This serves as a
“toggle” switch. Click it to turn it on, or click it to
turn it off.
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4.5 Moving Between Window Items

You may use either of the two standard Windows methods
of moving between items on your screen.

4.5.1 Mouse

To use your mouse to move between text boxes, button,
combo boxes, radio buttons, etc. on your screen, simply
place the mouse cursor over the item of your choice and
click the left mouse button.

4.5.2 Keyboard

To move to the next text box, press <Tab>.

To move back to the previous text box, press <Shift-
Tab>.



TCC for Windows

46 Using TCC for Windows

4.6 Exiting the Software

To exit TCC for Windows,
click on the Exit button
located in the lower right-
hand portion of the main
window.
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5 Security and User Administration
TCC for Windows provides a security function that protects
access to the program. This function allows the System
Manager, the Administrator, and multiple users to be setup
with user identifications and passwords. In addition, add,
delete, and update permissions can be allowed or disallowed
for each user.

Once the security function is setup and activated, TCC for
Windows displays the Security window each time the
software is started.

You must enter your user identification (initials) and
password to access TCC for Windows.
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5.1 Enabling the Security Function

In order to enable the security function, you must access
the Security window and setup user identifications and
passwords. To access the window, select Security → Enable
Security from the menu bar.
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5.2 Adding the System Manager

When the Security window is first displayed, notice that the
System Manager option button is already selected.

NOTE: More than one System Manager can
be setup on the system, but there must be at
least one System Manager.

The System Manager is the first level of user and has full
access to the system. In addition to entering, requesting,
and generating reports the System Manager can:

♦  Add, change, or delete users
♦  Add, change, view, and delete passwords
♦  Setup or change the system configuration options
♦  Change credit bureau preferences
♦   Delete the Transaction Log
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To setup the user
identification,
password, and
permissions for
the System
Manager:

1. Enter the System Manager’s initials in the User
Initials text box.

2. Enter the System Manager’s password in the
Password text box.

3. To verify the password, re-enter the password in
the Verify text box.

4. The System Manager has add, delete, and update
privileges. The Add, Delete, Update and Multi
Account check boxes have an " in each box and
are “grayed-out” for the System Manager.

5. Click on Save to save the information.
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After the information is saved, you can access all of the
other buttons at the bottom of the window.

New Displays a blank Security window.

Delete Deletes the currently displayed
user.

Save Saves the information entered in
the window.

Cancel Cancels the window and discards
unsaved information

View
Password

Displays the password in the
Password text box.

Exit Exits the Security window.
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5.3 Adding the Administrator

The Administrator is the second level of user and has access
to all levels of system administration EXCEPT:

♦  Setting the credit bureau preferences
♦  Deleting the Transaction Log

To setup the user identification, password, and permissions
for the Administrator:

1. Click on the New button on the Security window.
A blank window is displayed.

2. Click on the Administrator option button so that
an # appears in the button.

3. Enter the Administrator’s initials in the User
Initials text box.

4. Enter the Administrator’s password in the
Password text box.

5. To verify the password, re-enter the password in
the Verify text box.

6. Ensure that the Administrator has add, delete, and
update privileges. Click on the Add, Delete,
Update, and Multi Accounts check boxes, so that
an " appears in each box.

Click on Save to save the information.
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5.4 Adding Users

The third level of user is setup for data entry and credit
report submission only. This user cannot perform any
administrative tasks allowed to the System Manager and
the Administrator.

Multiple TCC for Windows users can be added through the
Security window.

1. Click on the New button on the Security window.
A blank window is displayed.

2. Click on the User option button so that an #
appears in the button.

3. Enter the new user’s initials, password, and the
access privileges you want this user to have.
If this User is allowed access to multiple accounts
for processing, ensure that you place an " appears
in the Multi Account check box. This option will
allow this User to select from all accounts
available in the Account Number field on the Request
Information window.

4. Click on Save to save the information.

5. Continue to add users by clicking on New,
entering the user information, and clicking on
Save.

6. To view the users, use the scroll bar at the bottom
of the window. The information for the different
users is displayed as you scroll left or right.

7. When you have entered all users, click on Exit to
close the Security window.
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5.5 Deleting Users

To delete a user from the system:

1. Use the scroll bar at the bottom of the Security
window to scroll to the user you want to delete.

2. Press the Delete button.

CAUTION: When you click on the Delete
button, the user is deleted. There is no
warning or confirmation window displayed.
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5.6 Deactivate Security

If you no longer require
security on TCC, simply
click on the Deactivate
Security option on the
Security menu.

Caution: This option permanently removes
all user security information. If you later
decide to reactive security again, all previous
security user information will be required to
be entered again.
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6 Entering Request Information
The TCC forWindows window consists of two sections:

♦  Request Information window
♦  Request Selections window

The Request Information window is used to enter all
pertinent information about the requester, the rental
property, and the primary applicant and spouse.

The Request Selection window is used to display an applicant
list, select the report type, and access the command button
functions.

Request Information

Request
Selection
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6.1 Request Information Window

The Request Information window consists of sections for
caller information, rental address information, applicant
information, and applicant address information. Required
information for each of these sections is displayed in red.

6.1.1 Caller Information Section

The Caller Information section contains information on the
customer requesting the resident screening report. The
majority of the information is entered automatically from
entries in the Preferences window.

The available fields and the fields required vary depending
on the options set in the Preferences window.

This section lets you
identify the purpose of this
request for information by
choosing from a drop down menu box. Your choices are
“Employment” or “Rental”. Additionally, the Member
Name, Caller Name, and Caller Phone are typically
completed with information previously entered.
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Note:  Access to different fields is controlled
depending on whether or not you belong to
an apartment association. If you do, you
should click on the Apartment Assoc menu
choice on the Options menu.

If the Apartment Assoc. menu
item has a " you will be
required to enter a Member
Name. If this field has not
been selected, the Member Name field will not be visible.
Required fields are identified in red.

The Account Number field and the Report Type field are also
“drop down” menu items that let you choose from
information previously completed.

6.1.2 Rental Address Section

The Rental Address section is used to record the address and
rent information for the rental property the applicant is
applying to rent.

Both the street type and the state can be selected from a
drop down list box.
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6.1.3 Applicant Section

The Applicant section is used to enter information about the
applicant(s).

When entering information in the Applicant section, the
text boxes accept alpha or numeric values only:

♦  Do not use punctuation within any text box.
♦  Do not use control characters within text box.
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6.1.4 Entering Applicant Information

The first set of name text boxes is for the Primary Applicant.
The second set of name text boxes is for the Joint Applicant.
When ordering an individual report, only the Primary
Applicant text boxes are accessible.

♦  Do not request a joint report for unmarried
applicants.

♦  If an applicant’s name is hyphenated or uses an
accent, do not enter the hyphen or accent in the
name field.

1. Enter the applicant’s last name, first name, and
middle initial in the respective text boxes.

2. The Gen drop down list box is used to indicate
generation. Select a valid entry from the list. Valid
entries are J, S, 2, 3, and 4.

3. Enter the Social Security Number in the SSN text
box. Do not use hyphens when entering Social
Security Numbers. The system enters the hyphens
automatically.
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4. Enter the applicant’s date of birth in the DOB text
box. You may enter the date directly, or by
selecting it off the “pop-up” calendar.

Simply click the " and then scroll to the correct year
and month. Next click on the
correct date to
complete the
entry.

5. Enter the
applicant’s
driver license
number in the
DL text box when this field is available.

6. Enter the 2-character state code where the driver
license was issued in the ST text box, or select the
state code from the drop down list.

7. If this is a joint request, use the scroll bar to the
right of the Primary Applicant section to display
the Joint Applicant section. It is available only when
the report you have previously chosen has been marked
as a “Joint Report”. Enter the spouse information in
this section.
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6.1.5 Address Section

The Address section is used to enter current and previous
addresses of the applicant(s).

When entering address information, the text boxes accept
alpha or numeric values only:

♦  Do not use punctuation within any text box.
♦  Do not use control characters within text box.

6.1.6 Entering Address Information

The first set of address text boxes is for the current Address.
The second set of name text boxes is for a Previous Address.
The third set of text boxes is for a Prior Address.

1. Enter the number of the house address in the Street
Num text box. When entering the number of the
house address, the system does not allow you to
enter spaces between numbers.
If the numeric address is followed by a fraction (such as
½ or ¼), leave out the fractional value. The system does
not allow you to enter fractional values.

2. Enter the street name in the Street Name text box.
3. Enter the street type in the Type text box, or select

the street type from the drop down list.

4. When applicable, enter the apartment or unit
number in the Unit text box. When entering an
apartment number, do not enter the # (number)
sign.

5. Enter the city in the City text box.

6. Enter the 2-character state code in the State text
box, or select the state code from the drop down
list.
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7. Enter the ZIP code in the Zip text box. The ZIP
code must be a valid code for the state entered in
the State text box.

8. In the From text box, enter the date the applicant
first lived at this address. You may enter the date
directly, or by selecting it off the “pop-up”
calendar.

Simply click the "
and then scroll to the
correct year and
month. Next click on
the correct date to
complete the entry.

9. In the To text box, enter the date the applicant last
lived at this address. You may enter the date
directly, or by selecting it off the “pop-up”
calendar.

Simply click the "
and then scroll to the
correct year and
month. Next click on
the correct date to
complete the entry.

10. When previous addresses are provided, click on the
down arrow or use the scroll bar to the right of the
Address section to display the Previous Address
section and then the Prior Address section. Enter
the address information in these sections.
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6.2 The Request Selection Window

The Request Selection
window contains the
applicant list and the
Command Buttons used to
access various functions.
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6.2.1 Applicant List Box

The Applicant List Box displays a list of completed and
saved applicant entries. The currently selected applicant is
highlighted and the applicant information is displayed in
the Request Information section. Clicking on a different
applicant causes that applicant to become the current
applicant.
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6.2.2 Command Buttons

Command buttons, located at the lower right of the
window, provide access to the New, Save, Cancel, Delete,
Applicants, Set Batch, Additional, and Exit functions.

Create a new, blank Request
Information window.

Save the current Request
Information window data.

Cancel additions or
modifications to the current
Request Information window
data.

Select the client(s) to be
deleted.
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You may select the clients individually using
standard selection methods or simply click on
the Select All button if you wish to mark all
clients for deletion.  You may also remove the
mark by simply clicking Unselect All.

To actually delete the selected records, click on
the Delete Selected button.

Note: No client records/reports are actually
deleted until you click the Delete Selected button.
Be careful, selected records will be permanently deleted
— there is no “undo”.

To delete records based on the date they were
entered, enter the date entered, or click on the "
arrow, in the Delete Before window. After you
have entered the date, click on the Delete Before
button to delete these records.

Click on the Done button to return to the
primary Request Information window.
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Displays the Applicants List
window. This window includes
applicant information, order
status, print status, and
transaction date. The Applicants
List window is a TCC form.
Refer to Chapter 7, Working with
Forms for information on
working with columns and
rows.
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Displays the Set Batch window.

You may select the clients individually using
standard selection methods or simply click on
the Select All button if you wish to include
everyone in the batch process.

Click on the Turn Batch On button to activate
batch processing or the Turn Batch Off button to
deactivate batch processing. Click on the Cancel
button to leave this window with no changes.
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This button allows you to
define additional information
required whenever you have
selected a Residential
Verification; Employment
Verification; or a Decision
Maker report. Clicking this
button will bring up the
following Additional Information
window.

Using the initial Options tab, you can request
residential verification of the Current Landlord
and the Previous Landlord.

You can also use this tab to conduct criminal
searches of the current, previous, and prior
addresses.
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The Residency Information tab is used to enter the
name and telephone number of the current and
previous landlords. These individuals will be
contacted to provide verification of submitted
residence information.
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The Primary Applicant Empl tab is used to provide
detailed employment information on the
primary applicant. This information will be used
to provide employment verification.

Note: Red field names denote required fields.
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The Secondary Applicant Empl tab is used to
provide detailed employment information on the
secondary applicant. This information will be
used to provide employment verification.

Note: Red field names denote required fields.

Exits the program.
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6.3 Status Bar

The status bar displays various messages during the process
of entering request information, transmitting reports, and
receiving reports. In addition, order and print status is
displayed. The information displayed in the status bar is
useful in the troubleshooting process.



TCC for Windows

76 Entering Request Information

This page left blank intentionally.



TCC for Windows

Ordering, Viewing, Printing, and Deleting Reports 77

7 Ordering, Viewing, Printing, and
Deleting Reports

TCC for Windows allows you to order a single report, or to
order multiple reports (batch processing).

The Report Type field in the Request Information window
provides a menu of available reports.

To select a report for the active client, simply click on it and
then click on the Save button.

Note: The active client is the one whose name
is visible in the Primary Applicant section of
the Request Information window.  It is also the
client whose name is highlighted in the
Request Selection window.

TCC reports are delivered to your computer after
processing is completed. You can view, print, and delete the
reports at any time after receiving the completed report.
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7.1 Ordering a Single Report

To transmit a single request for a resident or employment
screening report, you must:

Select the client you
wish to run a report on.

Their information will
be displayed in the
Request Information
window.

Select the reason you
want to run the
report.

Then select the
report you want to
run.

Last, click on the Save button in the Request
Selection window and then the Send button
located on the button bar. This will assure that
this combination of client and report
information is processed correctly by TCC.
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7.2 Ordering Multiple Reports

To transmit multiple requests:

7.2.1 Selection Method #1

Click on the Set
Batch command
button.

The Set Batch window is displayed.

In the Set Batch window, highlight the requests
you want to transmit. You can select all requests
by clicking on the Select All button.

The batch process will prepare to submit the
“currently selected report” for each client
selected.
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Click on the Turn
Batch On button to
exit and finish
marking the selected
individuals for batch
processing.

Note:  Be aware that TCC can only process
complete, accurate requests. Therefore, any
records that contain missing or inaccurate
information will be automatically removed from
the Batch process.

If you have selected an
individual for batch
processing in error,
simply reselect the
record and click on the
Turn Batch Off button
to unmark the individual
and exit.

Click on the Done
button to exit
without selecting
any records for batch
processing.

Click on the Batch button on the Menu bar to
transmit your batch request.

Once the Batch request has been submitted, all
batch processing flags are automatically removed
from all processed records.
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7.2.2 Selection Method #2

Select a record to
be included in the
batch process.

Use your mouse to “click” in
the Batch check box located
directly above the Report
Type window.

Note: If the Batch check box is “grayed-out”, you
have an error(s) in this record. This error is
identified in “red” on the status bar at the
bottom of the Request Information window.

Repeat this process for each record you want
included in the batch request.

Click on the Batch button on the Menu bar to
transmit your batch request.
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7.3 Viewing Reports

To view a report:

1. In the Request Selection window, highlight the
report you want to view by clicking on the
applicant’s name.

2. Click on the Reports button, located on the
button bar.

The Print Preview window allows you to preview the TCC
report on your screen.

Use the scroll arrows at the bottom of the window to view
additional pages of the report.

To print the current report, click on the Printer icon.

To exit the Print Preview window, click on the Exit Door
icon.
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7.4 Printing Reports

To print a report or group of reports:

1. In the Applicant List section, highlight the report or
group of reports you want to print by clicking on
the applicant’s name.

2. Click on the Reports button, located on the
button bar.

The above procedure prints the report to your default
printer.

Other printing options, such as selecting which printer to
print to, are available from File →→→→ Select Printer on the
menu bar. For additional information, refer to your
Windows documentation, or contact the Help Desk.

7.4.1 Automatic Printing

To automatically print reports when they are received, use
one of the following:

♦  Select File → AutoPrint from the menu bar.
♦  Click on the Printer icon located on the button

bar.

7.4.2 Reprinting an Existing Report

When TCC returns a report, it electronically stores the
report on your computer. Provided you have not, at any
time, selected the report for deletion, you can print an
additional copy of the report from your computer.

1. In the Applicant List section, locate and select the
report you want to reprint.

2. Click on the Print button on the button bar.

If you have previously received a report and since deleted it
from your computer, you must resend the request for
processing.
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7.5 Deleting Reports

All TCC reports are associated with client records.
Therefore, to delete a report(s) for an individual client, you
simply delete the client record. To delete a client(s) record
report(s):

1. In the Request Selection window, click on the
Delete command button. The Delete Records
window is displayed.

2. Select the applicant or applicants you want to
delete. If you want to delete all requests and
reports, click on Select All. If you want to delete
all requests and reports since a specific date, enter
the date in the Delete Since Date text box.

3. Click on the Delete Selected button (or the Delete
By Date button). A warning window is displayed.

4. If you are sure you want to permanently delete
the reports, click on OK. Click on Cancel if you
do not want to delete the selected reports.

5. When the requests and reports are deleted, click on
the Done button
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8 Viewing and Clearing Logs
TCC for Windows provides
transaction and error logging.
The Error Log displays the
date, time, error code, and a
description of the error. The
Transaction Log displays the
date and time of each
transaction.

All users can view the
Transaction Log and the Error
Log.

The ability to clear the
Transaction or Error Log is
restricted. Only the System
Manager has permissions to
clear these logs.

Note: At the first of every month, the Error
Log is cleared automatically by the system.
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8.1 Viewing the Transaction Log

To view the Transaction Log, select File → View Trans Log.
The Transaction Log window is displayed.
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The current page number of the Transaction Log is shown on
the Transaction Log tool bar, at the bottom of the window.

Additional functions can also be selected from the tool bar.

Click this icon to move to the
beginning of the transaction log
file.

Click this icon to move one
page to the left in the
transaction log file.

Click this icon to move to the
end of the transaction log file.

Click this icon to move one
page to the right in the
transaction log file.

Use the Zoom drop down text
box to enlarge or reduce the size
of the displayed Transaction
Log.
You can use the Scroll Bar at
the bottom of the screen to
move “left” or “right” to see
more of the transaction log.

Click on the printer icon to
print the transaction log on
your default printer.

Click this icon to adjust the
margins for your printed report.
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Use the margin windows to adjust the top,
bottom, left, or right margins. When you are
finished, click OK to save your changes and exit.
Click Cancel to exit without saving your
changes. To restore your margin settings to the
default system margins ( ½”), click the Default
button.

Click on this icon to select a
different font for your report.

Click on this icon to close the
View Transaction Log window
and return to TCC.
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8.2 Clearing the Transaction Log

To clear the Transaction Log, select File →→→→ Clear
Transaction Log. A delete warning window is displayed.

To delete all entries in the Transaction Log, click on the OK
button. An information window confirms that the
Transaction Log was successfully deleted. Click on the OK
button.
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8.3 Viewing the Error Log

To view the Error Log, select File → View Error Log. The Error
Log window is displayed.
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The current page number of the Error Log is shown on the
Error Log tool bar, at the bottom of the window.

Additional functions can also be selected from the tool bar.

Click this icon to move to the
beginning of the error log file.

Click this icon to move one
page to the left in the error log
file.

Click this icon to move to the
end of the error log file.

Click this icon to move one
page to the right in the error log
file.

Use the Zoom drop down text
box to enlarge or reduce the size
of the displayed error Log.
You can use the Scroll Bar at
the bottom of the screen to
move “left” or “right” to see
more of the error log.

Click on the printer icon to
print the error log on your
default printer.

Click this icon to adjust the
margins for your printed report.
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Use the margin windows to adjust the top,
bottom, left, or right margins. When you are
finished, click OK to save your changes and exit.
Click Cancel to exit without saving your
changes. To restore your margin settings to the
default system margins ( ½”), click the Default
button.

Click on this icon to select a
different font for your report.

Click on this icon to close the
View Error Log window and
return to TCC.
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8.4 Clearing the Error Log

To clear the Error Log, select File → Clear Error Log. A delete
warning window is displayed.

To delete all entries in the Error Log, click on the OK
button. An information window confirms that the Error Log
was successfully deleted. Click on the OK button.
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9 Management Reports
TCC for Windows provides a Management Report function.
Reports are available for:

♦  Inquiries by Member Number
♦  Inquiries by Building Code
♦  Inquiries by Date
♦  Report Types List
♦  System Configuration
♦  Users List

To access the Management Report function, select File →
Management Reports. The Management Reports window is
displayed.
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The drop down list text box provides access to the various
reports. Click on the arrow to display the list of reports
available.

To select a report for entry in the text box, click on the
desired report. Click on the Print button to preview the
report.
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9.1 Inquiries by Member Number Report

The Inquiries by Member Number report contains a list of
all resident screening report requests grouped by Member
Number.

The current page number of the report is shown on the
report tool bar, at the bottom of the window.

Additional functions can also be selected from the tool bar.

Click this icon to move to the
beginning of the report file.

Click this icon to move one
page to the left in the report
file.

Click this icon to move to the
end of the report file.

Click this icon to move one
page to the right in the report
file.

Use the Zoom drop down text
box to enlarge or reduce the size
of the displayed report.
You can use the Scroll Bar at
the bottom of the screen to
move “left” or “right” to see
more of the error log.

Click on the printer icon to
print the error log on your
default printer.

Click this icon to adjust the
margins for your printed report.
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Use the margin windows to adjust the top,
bottom, left, or right margins. When you are
finished, click OK to save your changes and exit.
Click Cancel to exit without saving your
changes. To restore your margin settings to the
default system margins ( ½”), click the Default
button.

Click on this icon to select a
different font for your report.

Click on this icon to close the
View Error Log window and
return to TCC.
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9.2 Inquiries by Building Code

The Inquiries by Building Code report contains a list of all
resident screening report requests sorted by the building
code.

The current page number of the report is shown on the
report tool bar, at the bottom of the window.
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Additional functions can also be selected from the tool bar.

Click this icon to move to the
beginning of the report file.

Click this icon to move one
page to the left in the report
file.

Click this icon to move to the
end of the report file.

Click this icon to move one
page to the right in the report
file.

Use the Zoom drop down text
box to enlarge or reduce the size
of the displayed report.
You can use the Scroll Bar at
the bottom of the screen to
move “left” or “right” to see
more of the report.

Click on the printer icon to
print the report on your default
printer.
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Click this icon to adjust the
margins for your printed report.

Use the margin windows to adjust the top,
bottom, left, or right margins. When you are
finished, click OK to save your changes and exit.
Click Cancel to exit without saving your
changes. To restore your margin settings to the
default system margins ( ½”), click the Default
button.

Click on this icon to select a
different font for your report.

Click on this icon to close the
report window and return to
TCC.
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9.3 Inquiries by Date Report

The Inquiries by Date report contains a list of all resident
screening report requests sorted by the request date.

The current page number of the report is shown on the
report tool bar, at the bottom of the window.

Additional functions can also be selected from the tool bar.

Click this icon to move to the
beginning of the report file.

Click this icon to move one
page to the left in the report
file.

Click this icon to move to the
end of the report file.

Click this icon to move one
page to the right in the report
file.
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Use the Zoom drop down text
box to enlarge or reduce the size
of the displayed report.
You can use the Scroll Bar at
the bottom of the screen to
move “left” or “right” to see
more of the report.

Click on the printer icon to
print the report on your default
printer.

Click this icon to adjust the
margins for your printed report.

Use the margin windows to adjust the top,
bottom, left, or right margins. When you are
finished, click OK to save your changes and exit.
Click Cancel to exit without saving your
changes. To restore your margin settings to the
default system margins ( ½”), click the Default
button.
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Click on this icon to select a
different font for your report.

Click on this icon to close the
report window and return to
TCC.
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9.4 Report Types List Report

The Report Types List report lists the currently defined
report types available for use.

The current page number of the report is shown on the
report tool bar, at the bottom of the window.

Additional functions can also be selected from the tool bar.
Click this icon to move to the
beginning of the report file.

Click this icon to move one
page to the left in the report
file.
Click this icon to move to the
end of the report file.

Click this icon to move one
page to the right in the report
file.
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Use the Zoom drop down text
box to enlarge or reduce the size
of the displayed report.
You can use the Scroll Bar at
the bottom of the screen to
move “left” or “right” to see
more of the report.

Click on the printer icon to
print the report on your default
printer.

Click this icon to adjust the
margins for your printed report.

Use the margin windows to adjust the top,
bottom, left, or right margins. When you are
finished, click OK to save your changes and exit.
Click Cancel to exit without saving your
changes. To restore your margin settings to the
default system margins ( ½”), click the Default
button.

Click on this icon to select a
different font for your report.

Click on this icon to close the
report window and return to
TCC.
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9.5 System Configuration Report

The System Configuration report lists the current system
configuration, including bureau preferences, modem baud
rate, access phone numbers, etc.

The current page number of the report is shown on the
report tool bar, at the bottom of the window.
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Additional functions can also be selected from the tool bar.

Click this icon to move to the
beginning of the report file.

Click this icon to move one
page to the left in the report
file.

Click this icon to move to the
end of the report file.

Click this icon to move one
page to the right in the report
file.

Use the Zoom drop down text
box to enlarge or reduce the size
of the displayed report.
You can use the Scroll Bar at
the bottom of the screen to
move “left” or “right” to see
more of the report.

Click on the printer icon to
print the report on your default
printer.
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Click this icon to adjust the
margins for your printed report.

Use the margin windows to adjust the top,
bottom, left, or right margins. When you are
finished, click OK to save your changes and exit.
Click Cancel to exit without saving your
changes. To restore your margin settings to the
default system margins ( ½”), click the Default
button.

Click on this icon to select a
different font for your report.

Click on this icon to close the
report window and return to
TCC.
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9.6 Users List Report

The Users List report lists the users setup to use TCC for
Windows. This report is available only when Security is
activated.

The current page number of the report is shown on the
report tool bar, at the bottom of the window.
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Additional functions can also be selected from the tool bar.

Click this icon to move to the
beginning of the report file.

Click this icon to move one
page to the left in the report
file.

Click this icon to move to the
end of the report file.

Click this icon to move one
page to the right in the report
file.

Use the Zoom drop down text
box to enlarge or reduce the size
of the displayed report.
You can use the Scroll Bar at
the bottom of the screen to
move “left” or “right” to see
more of the report.

Click on the printer icon to
print the report on your default
printer.
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Click this icon to adjust the
margins for your printed report.

Use the margin windows to adjust the top,
bottom, left, or right margins. When you are
finished, click OK to save your changes and exit.
Click Cancel to exit without saving your
changes. To restore your margin settings to the
default system margins ( ½”), click the Default
button.

Click on this icon to select a
different font for your report.

Click on this icon to close the
report window and return to
TCC.
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10 Working with Forms
The TCC forms are designed to incorporate numerous
standard spreadsheet features. These features assist in data
entry, viewing, and formatting tasks. The Applicant
window is a TCC form. Use the following procedures to:

♦  Resize Rows
♦  Resize Columns
♦  Collapse and Expand Columns
♦  Move Columns
♦  Lock Columns
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10.1 Resizing Rows

To change the row height:

1. Position the cursor in the row header at the far left
of the window.

2. Move the cursor to the line between the rows. The

cursor shape changes to .

3. Click and hold down the left mouse button.

4. Drag the row to the desired width. All the rows in
the form automatically change to the adjusted
size.
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10.2 Resizing Columns

To change the column width:

1. Position the cursor in the column heading you
want to resize.

2. Move the cursor to the line between the columns.

The cursor shape changes to .

3. Click and hold down the left mouse button.

4. Drag the column to the desired width.
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10.3 Collapsing and Expanding Columns

At times you may want to collapse a column so you can
view other columns more easily.

To collapse a column, right-click on the column heading.

To expand a column, right-click again on the collapsed
column heading.



TCC for Windows

Working with Forms 117

10.4 Moving Columns

Column positions can be changed using the drag and drop
feature. To move a column:

1. Position the cursor in the column heading you
want to move.

2. Click and hold down the left mouse button.

3. Drag the column to the new position and release
the mouse button.

Another way to change the position of a column is to:

1. Position the cursor in the column heading.

2. Click the left mouse button. An arrow appears on
the right side of the heading.

3. Click on the arrow to display a list of columns
currently available in the form.

4. Click on the column you want to appear in the
current column position. The selected column and
the current column change positions.

When you exit the window, the column position is saved.
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10.5 Column Locking

Depending on the number of columns in a form and the
width of the columns, it may be necessary to scroll the
form to view all of the data. As you scroll to the right, the
column(s) on the left of the window are no longer visible.

TCC for Windows provides a Column Locking feature that
allows the  “locked” columns to remain fixed and visible as
you scroll to the right.

To lock a column or multiple columns:

1. Position the cursor between the row heading and

the first column. The cursor changes to .

2. Click the left mouse button and drag the locking
bar to the desired column.

3. Release the mouse button. The column(s) to the
left of the locking bar remain fixed when scrolling.


	Introduction
	Features
	Hardware Requirements
	Software Requirements
	Technical Support

	Installing the Software
	Windows 3.1 Installation
	Windows 95/98 Installation
	Automatic Installation Using A CD-ROM
	Manual Installation

	Starting the Software
	Starting TCC Using Windows 3.1
	Starting TCC Using Windows 95/98

	Exiting the Software

	Configuring the Software
	Customer Profiles Window
	Completing a profile

	Phone Numbers Window
	Report Types Window
	Report Types
	Setting Up New Reports
	Setting a Default Report Type

	Port Setup
	Modem Setup
	Modem Utilities

	Reconnect Modem

	Using TCC for Windows
	Starting TCC Using Windows 3.1
	Enter User Initials  and Password

	Starting TCC Using Windows 95/98
	Enter User Initials and Password

	Menu Bar
	File Menu
	Setup Menu
	Options Menu
	Security Menu
	Help Menu

	Button Bar
	Moving Between Window Items
	Mouse
	Keyboard

	Exiting the Software

	Security and User Administration
	Enabling the Security Function
	Adding the System Manager
	Adding the Administrator
	Adding Users
	Deleting Users
	Deactivate Security

	Entering Request Information
	Request Information Window
	Caller Information Section
	Rental Address Section
	Applicant Section
	Entering Applicant Information
	Address Section
	Entering Address Information

	The Request Selection Window
	Applicant List Box
	Command Buttons

	Status Bar

	Ordering, Viewing, Printing, and Deleting Reports
	Ordering a Single Report
	Ordering Multiple Reports
	Selection Method #1
	Selection Method #2

	Viewing Reports
	Printing Reports
	Automatic Printing
	Reprinting an Existing Report

	Deleting Reports

	Viewing and Clearing Logs
	Viewing the Transaction Log
	Clearing the Transaction Log
	Viewing the Error Log
	Clearing the Error Log

	Management Reports
	Inquiries by Member Number Report
	Inquiries by Building Code
	Inquiries by Date Report
	Report Types List Report
	System Configuration Report
	Users List Report

	Working with Forms
	Resizing Rows
	Resizing Columns
	Collapsing and Expanding Columns
	Moving Columns
	Column Locking


